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1 INTENDED AUDIENCE 

An output of the INDIRES project is user documentation for each of the products 
produced during the project. However, the status of the various products differs and, 
for this reason, the intended audience for the User Documentation will be different for 
each product. It is necessary, therefore, to indicate the type of user who will benefit 
from this particular User Document. 

The software for simulating the evacuation of a mine is fully complete. As such, the 
information provided in this User Document could be utilised by end users who have a 
need for this functionality. Such users can consider the instructions on how to use the 
software as definitive. 

End users who want to know more are referred to Section 5. 
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2 OVERVIEW 

The document is divides into two different sections. 

The first part provides a detailed description of the evacuation software and presents 
all the steps needed to correctly build a model, with particular emphasis on the 
individual steps. 

This way, it is possible for the software user to easily follow each step and build a 
model of a mine where an evacuation will be necessary. 

The second part presents a case study of a coal mine where miners are attempting to 
escape from a fire and reach a safe zone. Unlike the first part, this is more focussed on 
a real-world situation. 
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3 SOFTWARE DESCRIPTION 

This section describes the steps to create a model. 

3.1 Introduction 

Pathfinder is an agent-based egress and human movement simulator. It provides a 
graphical user interface for simulation design and execution as well as 2D and 3D 
visualization tools for results analysis. 

3.1.1 Graphical User Interface 

Pathfinder includes a graphical user interface that is used primarily to create and run 
simulation models, as shown Figure 1, which illustrates the Velenje Mine. 

 

Figure 1 – 3D View of a Coal mine Modelled in Pathfinder 

Pathfinder also includes a second program designed specifically for high-performance 
visualization of 3D time history. 

In addition to 3D visualization, Pathfinder also provides output in the form of 2D time 
history plots of CSV (comma separated values) out files and a text summary of room 
clearing times and doorway flow rates. 

3.1.2 Model Representation 

The movement environment is a 3D triangulated mesh designed to match the real 
dimensions of a building model. This movement mesh can be entered manually or 
automatically based on imported data (e.g. FDS geometry). 

Walls and other impassable areas are represented as gaps in the navigation mesh. 
These objects are not actually passed along to the simulator but are represented 
implicitly because occupants cannot move in places where no navigation mesh has 
been created. 
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Doors are represented as special navigation mesh edges. In all simulations, doors 
provide a mechanism for joining rooms and tracking occupant flow. Depending on the 
specific selection of simulation options, doors may also be used to explicitly control 
occupant flow. 

3.1.3 Simulation Modes 

Pathfinder supports two movement simulation modes. In "Steering" mode, occupants 
use a steering system to move and interact with others. This mode tries to emulate 
human behavior and movement as much as possible. SFPE mode uses a set of 
assumptions and hand-calculations as defined in the Engineering Guide to Human 
Behavior in Fire (SFPE, 2003). In SFPE mode, occupants make no attempt to avoid one 
another and are allowed to interpenetrate, but doors impose a flow limit and velocity 
is controlled by density. 

3.1.4 System Requirements 

The minimum requirements to run Pathfinder include: 

 32 or 64-bit Windows 7 or higher, 

 A processor of the performance of an Intel i5, 

 4GB of RAM, 

 Graphics support for OpenGL 1.2. 

3.1.5 Where to Download the Software 

The software can be downloaded in the link 
https://support.thunderheadeng.com/pathfinder/ 

There is a free trial version for 30 days, but if one wants to have access to it for a 
longer period, it must be purchased. 

3.2 Software Basics 

Pathfinder provides three main views for working on evacuation models: the 2D View, 
3D View, and Navigation View. These views represent the current model. If an object is 
added, removed, or selected in one view, the other views will simultaneously reflect 
the change. 

 Navigation View: This view lists all objects in the model in a hierarchical 
format. It can be used to quickly locate and modify objects by name. 

 3D View: This view shows a 3D representation of the current model. The model 
can be explored and modified using various tools. 

 2D View: This view is very similar to the 3D View, but it provides an additional 
snapping grid and an orthographic view of the model, as shown in Figure 2.  
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Figure 2 – 2D View of a Coal Mine Modelled in Pathfinder 

3.2.1 Navigating the 3D View 

Several tools are provided for navigating through the model in the 3D view, including 
orbit, roam, pan, and zoom tools, as shown in Figure 3. 

 

Figure 3 – 3D navigation Options 

The main navigation tool for the 3D view is the Orbit tool (second in the figure). By left 
clicking and dragging, the model is rotated about its centre point. 

Another navigation tool in the 3D view is the Roam tool (third in the figure). This tool 
allows the camera to move in and out of the model at will. It has a higher learning 
curve but is the most flexible viewing tool because it allows the camera to be placed 
anywhere in the model. 

The other navigation tools include a pan/drag tool, which moves the camera left and 
right and up and down, a zoom tool, which zooms in and out of the model while click-
dragging, and a zoom box tool, which allows a box to be drawn that specifies the zoom 
extents. 

Pathfinder can also be navigated while using the Selection/manipulation tool (first in 
the figure). To Orbit the camera while in perspective view, use a right-click and drag 
combination. Similarly, use a middle-click and drag to Pan in perspective view. 

3.2.2 Navigating the 2D View 

Navigation in the 2D view is simpler than in the 3D view. The selection tool not only 
allows objects to be selected if single-clicked, but it allows the view to be panned by 
middle or right-clicking and dragging, and the view to be zoomed by using the scroll 
wheel. The drag and zoom tools are also separated into separate tools for 
convenience. 
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3.2.3 Model Organisation with Groups 

The main method of organization in Pathfinder is to use groups. In every model there 
are already some implicit groups that cannot be modified, including Views, Imported 
Geometry, Profiles, Vehicle Shapes, Assisted Evacuation Teams, Behaviours, Occupant 
Sources, Occupants, Movement Groups, Movement Group Templates, Elevators, 
Measurement Regions, and Floors as shown in Figure 4. Sub-groups can be created to 
further organize the model as discussed in the following sections. 

 

Figure 4 – Predefined Groups in Pathfinder 

3.3 Creating Movement Space 

Pathfinder is built on the idea of creating floor space on which occupants can walk. 
Every navigation component drawn in Pathfinder is some piece of flooring that can be 
travelled on, which can range from floors, to doorways, to stairs. 

The main egress components include rooms, which are empty floor spaces bounded 
by walls, doors, which connect rooms on the same level, stairs/ramps, which connect 
rooms on different levels, and elevators, which connect multiple levels. Rooms can 
have any polygonal shape and can never overlap on the same level. Doors can be 
either thick if they are occupying a doorway (the area between two rooms) or thin if 
they are simply connecting two touching rooms. Stairs/ramps are always rectangular 
and implicitly contain a thin door on each end to connect the adjacent rooms. 
Elevators can be any shape and can travel in any direction. 

3.3.1 Floors 

Floors are the primary method of organization in Pathfinder. At their most basic level, 
they are simply groups in which rooms, doors, stairs, ramps, and exits can be placed, 
but they also control the drawing plane for most tools and filtering of imported 
geometry. 
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In every Pathfinder model, at least one floor must exist, and at any given time, there is 
one active floor. Whenever any navigation object is drawn, it will either be placed in 
the active floor or a subgroup of the active floor. 

In the case of a mine, it is likely that there will be quite a few floors, as shown in 
Figure 5. 

 
Figure 5 – Floors Defined for a Coal Mine Modelled in Pathfinder 

Floors can also be created manually at any time. To do so, click on the floor drop-down 
box above the Navigation View, and select <Add New…> as shown in Figure 6. 
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Figure 6 – Creation of Floors of a Coal Mine Modelled in Pathfinder 

Floor Properties 

To edit a floor’s properties, first select the desired floor. The property panel, as shown 
in Figure 7, will appear, showing the floor name, its working Z location, and the Z 
clipping planes for imported 3D geometry. 

 

Figure 7 – Example of Floor Features in a Coal Mine Modelled in Pathfinder 

3.3.2 Rooms 

Rooms are open spaces in which occupants can freely travel. Each room is bounded on 
all sides by walls. Rooms can be drawn so that they touch each other, but an occupant 
can only travel between them if they are connected by a door. Only one room can 
occupy a given space at any time, so if one room is drawn overlapping another, the 
overlapping area will be subtracted from the old room and given to the new. Rooms 
can also be merged into one, separated into constituent parts, and have internal, thin 
boundaries drawn in them. 
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Adding New Rooms 

Pathfinder provides two tools for adding new room geometry: 

 Polygonal Room Tool: this tool allows for the creation of complex shapes with 
any number of vertices. Left click anywhere in the model to set the first point 
and continue left clicking to add more points to the polygon. When at least 
three points are defined, right-clicking will close the polygon and complete the 
shape. Alternatively, x-y coordinates can be entered from the keyboard with 
the Add Point and Close Polygon buttons from the property panel. 

 Rectangular Room Tool: this tool creates simple rectangular geometry by left 
clicking two points in the model. The rectangular area can also be created by 
entering coordinates for two points in the property panel and clicking the 
Create button. 

Merging Rooms 

The Merge command is used to join two or more rooms that share boundaries into one 
room. To use it, select the neighbouring rooms and select Merge from either the Model 
menu or the right-click menu  

 

Figure 8 – Example of Room Merging in a Coal Mine Modelled in Pathfinder 

Preventing Room Crossing 

In some cases, such as modelling seating rows or shops in a mall, it may be desirable 
to only allow occupants to exit the room and not cross through it. This can be 
accomplished by making all the doors connected to the room one-way (see Section 
3.3.3) and ensuring that their directions point out of the room. Pathfinder provides a 
tool to make this easy. Instead of individually setting the one-way status of all the 
connecting doors, perform the following: 
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 Select the room(s) that should not be crossable.  

 Right-click one of the rooms, and from the menu select Make Doors One-way  

 A dialog will appear as in Figure 9. From this dialog, choose whether occupants 
can only Enter or Exit the room. If any of the room’s doors were already 
marked as one-way, another option will be provided to overwrite the one-way 
status of those doors. Press OK in this dialog to make the doors one-way. 

 

Figure 9 – Example of Preventing Room Crossing in a Coal Mine Modelled in Pathfinder 

3.3.3 Doors 

In Pathfinder, occupants cannot pass between two rooms unless they are joined by a 
door. Also, the simulator requires that each occupant must have a path to at least one 
exit door. Doors provide useful flow measurements in simulation results. Also, in the 
SFPE mode doors act as the primary flow control mechanism. You can add doors using 
the Add a New Door tool. 

To edit a door’s properties, select the door. Its properties will appear in the property panel as 
shown in Figure 10. 

 

Figure 10 – Example of Door Features in a Coal Mine Modelled in Pathfinder 
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The main features are as follows: 

 Width: The width of the door. Changing this value will change the width of the 
door, but the value cannot exceed the length of its room edge.  

 Flow Rate: Checking this box overrides the default door flow rate setting in the 
Simulation Parameters Dialog. Setting this value controls the maximum 
occupant flow rate for the door in units of pers/t. This could be used, for 
instance, to specify a gated mechanism, such as a turnstile. A value of 0.9 
pers/s, for instance, would mean that one occupant can go through the door 
every 1.1 seconds (1/0.9).  

 State: Indicates the timed opening, closing, and changing the one-way direction 
of the door. A one-way door is one through which occupants can only travel in 
one direction. By default, all doors are always open throughout the simulation. 
To change this, click the link. The Edit Door State dialog will appear as shown in 
Figure 11. This dialog allows the initial state of the door to be specified as well 
as additional timed states. 

 

Figure 11 – Scripted Events Dialog in Pathfinder 

 Wait Time: an amount of time for which each occupant must wait at the door 
before walking through it. This can be used to simulate turnstiles or doors with 
access keys. The specific wait time for each occupant will be drawn at random 
from a predefined continuous or discrete distribution.  
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 Accepted Profiles: A list of occupant profiles for which the occupants can enter 
this door. By default, all occupant profiles are accepted. 

3.3.4 Elevators 

Pathfinder supports elevators in egress-mode operation, which is based on current 
thinking described in Using Elevators In Fires. The basic operation of elevators in 
evacuations can be summarized as follows. 

 Each elevator has one discharge floor. This is where the elevator starts at the 
beginning of the simulation and where it will take occupants it has picked up. 

 Each elevator has at least one pickup floor. These are floors where the elevator 
will pick up occupants that it will take to the discharge floor. 

 An elevator is called on a pickup floor by an occupant when they come within 
0.5m of the elevator door. 

 The elevator uses a priority system to serve called floors. By default, floors are 
served from top to bottom; however, other floors can be given higher priority 
to simulate fire floors. 

 When travelling to a pickup floor, the elevator can change to another pickup 
floor mid-flight if a higher-priority floor is called that is above the elevator’s 
current location  

 Once an elevator has picked up occupants, it will only travel to the discharge 
floor before letting the occupants off. It will not travel to any other floor to pick 
up more occupants  

Creating Elevators 

Elevators can be made after creating the rest of the model. Perform the following steps 
to create the elevator: 

 Draw a room that defines the shape of the elevator, preferably on the discharge 
floor. 

 Draw all doors on the boundary of the base room. Occupants will use these 
doors on every floor to enter and exit the elevator. 

 Right-click the base room, and from the right-click menu, select Create 
Elevator…. This will show the New Elevator dialog. 

 In the New Elevator dialog, enter all parameters for the elevator: 

 Name – the name of the elevator, 

 Nominal Load – the number of people in a full load (estimated), 

 Elevator Geometry – the base room that defines the elevator shape, 

 Travel Direction – a vector defining the direction the elevator can travel, 
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 Elevator Bounds – this defines the bottom-most and top-most floors the 
elevator can connect to, 

 Elevator Timing – this defines a basic timing model used to calculate the 
travel times for the elevator to travel from the discharge floor to each 
pickup floor, 

 Acceleration (Elevator Timing) – [optional] the acceleration of the 
elevator, 

 Max Velocity (Elevator Timing) – the maximum velocity that the elevator 
can accelerate to, 

 Open+Close Time (Elevator Timing) – the sum of the door opening and 
closing times. Each value will be taken as half of this, 

 Call Distance – the distance away from the elevator door at which an 
occupant can call the elevator, 

 Double-Deck – whether the elevator should use two connected decks to 
transport occupants. 

 Press OK to create the elevator. 

3.3.5 Exits 

In Pathfinder, exits are merely thin doors that exist on the boundary of the model. An 
exit can only have a room on one of its sides.  

Exits are created in almost the same way as thin doors. The only difference is that the 
door must lie on an edge of a room, and the edge must not be shared between two 
rooms. 

Exit doors are displayed the same as thin doors except that they are green as shown in 
Figure 12. 

 

Figure 12 – Example of Exit Door (Green) in a Coal Mine Modelled in Pathfinder 
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3.4 Importing Files 

Pathfinder can import a large number of image and CAD formats. Imported files can be 
used as an aid to more quickly generate the navigation mesh and give more context 
and visual appeal to a simulation. 

3.4.1 Importing CAD Files 

Pathfinder can import geometry from several CAD formats, including AutoCAD’s DXF 
(Drawing Exchange Format), DWG, FBX, DAE, and OBJ files. 

 DXF – a basic CAD format provided by Autodesk. This format supports robust 
geometry types, including 3D faces, lines, and text, but it does not support 
material information, such as textures, lighting parameters, etc. In Pathfinder, 
the main purpose of the imported geometry is for display and floor extraction. 
Because of this, Pathfinder does not need to perform any special post-
processing of the imported geometry. 

 DWG – similar to DXF, but it also has basic support for materials, including 
textures. It has only basic support for mapping textures onto objects, however, 
and few CAD applications can export DWG files. Some, such as Revit, exclude 
material and texture information  

 FBX – provides support for 3D faces only, but it has very good support for 
material information and materials mapping. In addition, many 3D modelling 
applications have built-in support for exporting FBX files. This is an excellent 
format for importing 3D building models into Pathfinder  

To import one of these files, under the File menu, select Import… and select the 
desired file. After selecting a file, a step-by-step dialog will open as shown in 
Figure 13. 
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Figure 13 – Import Option in Pathfinder 

3.4.2 Import REVIT Files 

While Pathfinder cannot directly import Autodesk Revit files (RVT), there are several 
ways to export the data from Revit into a file format that Pathfinder can read. Each 
method has advantages and disadvantages as discussed below. 

 Revit to DWG (direct): The first method is to export a DWG directly from Revit, 
which can then be imported into Pathfinder. While simple to perform and only 
requires Revit, this method loses all information about materials, including 
textures, due to Revit’s limited DWG support. To perform the export in Revit 
Architecture 2014, perform the following: 

 Open the desired RVT file within Revit Architecture. 

 Click the Revit icon at the top left. 

 Select Export->CAD Formats->DWG. 

 In the DWG Export dialog, for Export, select <In session view/sheet set>. 

 For Show in list, select Views in the Model. 

 Click the Check None button, and then in the view table, select the check 
box for 3D View. 

 Click the Next… button and choose a file name for the DWG file. 

 Click OK to create the DWG. 

 Import the DWG into Pathfinder. 

 Revit to FBX (direct): This method exports an FBX file directly from Revit, 
which can then be imported into Pathfinder. As with exporting a DWG, this 
method is simple to perform and only requires Revit. Unfortunately, this 
method also loses all information about materials and textures because Revit 
encrypts the material data, making it unreadable by Pathfinder. To export using 
Revit Architecture 2014, perform the following:  

 Open the desired RVT file within Revit Architecture. 

 Click the Revit icon at the top left. 

 Select Export->FBX. 

 Choose a file name for the FBX file. 

 Click OK to create the FBX. 

 Import the FBX into Pathfinder. 

 Revit to FBX using third-party plugin: This method requires the use of a third 
party plugin, but it generally produces good results with materials, textures, 
and texture coordinates well-supported. In many cases, this is the most reliable 
method of reproducing the graphical representation of the original Revit file 
within Pathfinder. SimLab Soft is one company that provides commercial FBX 
export plugins for several CAD packages, including Revit and Sketchup, among 
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others, and provides robust texture support. To export using a third-party 
plugin, perform the following:  

 Download and install the appropriate plugin. 

 Follow the plugin instructions to export an FBX file from Revit. If the 
plugin supports embedded media, select this option before exporting. 
This option allows textures to be embedded into the FBX file, making it 
much easier to transfer the FBX to another computer, as only one file has 
to be transferred. 

 If the FBX file is to be imported into Pathfinder on the same computer as 
the one that exported the file or the embedded media option was selected, 
continue to the next main bullet, otherwise, some additional steps may be 
necessary to ensure the textures can be found when importing into 
Pathfinder. 

 Determine the directory into which the FBX exporter saved the 
textures. Some exporters may place the textures in a sub-directory of 
the FBX file and give it the same name as the FBX file. Others may save 
the textures to a common program-specific location. 

 Cut this folder and paste it in the same location as the FBX file. The 
pasted folder may be left as is or renamed to be the same as the FBX 
file, without the .fbx extension. 

 Transfer the FBX file and the texture folder to the computer that will 
be importing the FBX file into Pathfinder. 

 Import the FBX file into Pathfinder. 

 Revit to FBX to AutoCAD to DWG: This method requires both Revit and 
AutoCAD and does not perform a perfect conversion, but it retains some 
information about materials and texture coordinates. The steps described here 
use Revit Architecture 2014 and AutoCAD 2014: 

 Open the desired RVT file within Revit Architecture. 

 Click the Revit icon at the top left. 

 Select Export->FBX. 

 Specify the desired filename and click Save. 

 Open AutoCAD. 

 On the Insert tab in the ribbon, select Import. 

 Select the FBX file created by Revit. 

 The FBX Import Options dialog will appear. The following are 
recommended settings for the FBX import: 
 Import section: Make sure Objects and Materials are checked. Lights 

and Cameras are unused in Pathfinder. 
 Assign Objects to Layers: any option may be selected, but By Material 

is a useful option for Pathfinder. 
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 Unit Conversion: This section is somewhat misleading. While the 
Current Drawing Unit is correct, the FBX file unit tends to be incorrect. 
No matter what unit is displayed in the greyed-out text for FBX file 
units, the actual unit in the FBX file is always FOOT. The appropriate 
values need to be specified to make the proper unit conversion. 

 Block: Uncheck Insert file as block. 

 Click OK to finish the import. You may receive a warning about the clip 
plane of the camera. 

 Save the file as a DWG. 

 Import the DWG into Pathfinder. 

3.4.3 Importing Pyrosim and FDS Files 

Both PyroSim and FDS files can be imported into Pathfinder. To import one of these 
file types, select Import… under the File menu. Then select the appropriate FDS or 
PSM file. The imported geometry will be added to the Imported Geometry group. 

3.4.4 Importing FDS Output Data 

Pathfinder can use the PLOT3D data output from FDS to create time history data for 
each occupant as they move throughout the simulation. In cases where FDS PLOT3D 
output data is available for CO Volume Fraction, CO2 Volume Fraction, and O2 Volume 
Fraction, Pathfinder will also output FED for each occupant specified. 

FDS data integration is a measurement only and does not alter the movements or 
decision making within the Pathfinder simulation. However, enabling this feature 
causes simulations to require additional runtime because of the additional processing 
load relating to reading the FDS output files and mapping PLOT3D data to occupants. 

To enable FDS Integration: 

 On the Simulation menu, click Simulation Parameters. 

 On the FDS Data tab, select Enable FDS Integration.  

 Click Edit… and select the SMV file from the FDS simulation of interest. 

The dialog will display information about the attached SMV file and indicate which 
quantities were found. 
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Figure 14 – Import Option in Pathfinder 

The parameter Hypoxia FED Threshold defines the oxygen concentration at which 
hypoxia contributes to the FED calculation. When oxygen concentration is above the 
threshold, low O2 hypoxia will not contribute to accumulated FED. The default value 
of 19.5% prevents misleading FED accumulation for occupants that are in safe 
conditions. 

To enable FED and PLOT3D quantity output for one or more occupants: 

 Select one or more occupants. 

 In the selection editor, click More. 

 In the Additional Occupant Properties dialog, on the Output tab, enable Print 
CSV Data. 

 In the Print CSV Data dropdown, select Yes. 

Once the simulation has completed, CSV data is available for each specified occupant 
in the output folder. 

3.5 Creating Occupants 

In Pathfinder, occupants are defined in two parts: profiles and behaviors. The profile 
defines fixed characteristics of the occupants, such as maximum speed, radius, avatar, 
and colour. The behavior defines a sequence of actions the occupant will take 
throughout the simulation, such as moving to a room, waiting, and then exiting. 

3.5.1 Profiles 

Pathfinder uses an occupant profile system to manage distributions of parameters 
across groups of occupants. This system helps you control the occupant speed, size, 
and visual distributions. 
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To open the Edit Profiles dialog: on the Model menu, click Edit Profiles. 

 
Figure 15 – Import Option in Pathfinder 

Characteristics Tab 

 Priority Level of the occupants are completely relative and higher values 
indicate a higher priority. For instance, if three occupants meet with assigned 
priorities of 4, 6, and 12, they will behave the same as if their priorities were 0, 
1, and 2, respectively. This allows occupants of lower priority to move out of 
the way of those of higher priority. This would be useful when simulating first 
responders that must be able to move easily through a crowd of occupants. 

 The Shape of the occupant can be either a cylinder or a polygonal shape. In the 
case of a Cylinder, Diameter, Height, Reduction Factor and Minimum Diameter 
can be specified. 

 Diameter of the cylinder representing the occupant. This is used for collision 
testing and path planning during the simulation. This value will also affect how 
many occupants can be added to a room without overlapping. The default value 
of 45.58cm is based on the average of measurements of male and female 
persons from nine countries. As shown in the Pathfinder Validation and 
Verification Manual, this size (and Comfort Distance) results in movement that 
matches the SFPE and experimentally measured fundamental diagrams. 
Caution should be used in changing the default Diameter value. 

 Height specifies the height of the cylinder used for inter-occupant collisions. 
This is useful for limiting collisions that might occur between occupants on 
different floors when the floors have been modelled close together. 
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 Reduction Factor is an optional Steering Mode Parameter that specifies how 
well an occupant may squeeze past other occupants in tight situations. This 
factor should be specified as greater than 0 and less than or equal to 1. This 
factor is directly multiplied by the shoulder width during calculations, so a 
Reduction Factor of 0.5 would lead to the occupant being able to squeeze to 
one-half his shoulder width. 

 Minimum Diameter for movement through narrow geometry (optional) 
specifies a diameter to which the occupants can squeeze their bodies to pass 
through a narrow area, such as narrow doors or corridors. Occupants will 
reduce their diameter to this value only if the geometry would otherwise 
prevent them from further following their path. The default value of 33.00cm is 
based on the maximum depth of a human body for 95th percentile of measured 
individuals. 

Movement Tab 

 Initial Orientation: The degree counter-clockwise from the positive x-axis 
which the occupants will use as their orientation in the beginning of the 
simulation. 

 Requires Assistance to Move: Whether the occupant requires assistance from 
another occupant in order to move. 

 Ignore One-way Door Restrictions: Whether the occupant will ignore the 
direction specified for one-way doors. 

 Walk on Escalators: Whether the occupant will walk on escalators and moving 
walkways. 

 Restricted Components: Specifies which doors, rooms, stairs, ramps, and 
elevators the occupant will accept or reject during path planning. 
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Door Choice Tab 

The Door Choice tab provides parameters related to how occupants choose doors to exit from 
in each room. 

 Current Room Travel Time: The cost of travelling to a door in the occupant’s 
current room, ignoring all other occupants. 

 Current Room Queue Time: The cost of waiting in a queue at a door in the 
occupant’s current room.  

 Global Travel Time: The cost of travelling from a door to an exit or the 
occupant’s next goal, ignoring all other occupants.  

 Elevator Wait Time: The time during which the occupant will prefer to use an 
elevator, even if using a stair would be faster.  

 Current Door Preference: Makes occupants stick to their currently chosen 
doors. 

 Current Room Distance Penalty: Exponentially increases the cost associated 
with travelling based on how far the occupant has travelled in the current 
room. 

Advanced Tab 

The Advanced tab provides the following parameters: 

 Acceleration Time: The amount of time it takes for the occupant to reach 
maximum speed. 

 Persist Time: The amount of time an occupant will maintain an elevated 
priority when trying to resolve movement conflicts. 

 Collision Response Time: Controls the distance at which an occupant will start 
recording a cost for colliding with other occupants when steering. 

 Slow Factor: The fraction of the occupant’s speed in which they are considered 
to be slow. 

 Wall Boundary Layer: Specifies the distance that occupants try to maintain with 
walls and other static obstructions. 

 Comfort Distance: The desired distance one occupant will try to maintain with 
others in a queue. 

Output Tab 

The Output tab provides the Print CSV Data option. When checked, additional CSV 
output data is generated for each occupant using this profile. The file contains data for 
each time step, such as occupant speed, location, etc. 
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3.5.2 Behaviours 

Behaviours in Pathfinder represent a sequence of actions the occupant will take 
throughout the simulation. Once the occupant has completed all actions, they are 
removed from the simulation. Actions may be added that can make the occupant wait 
or travel to a destination, such as a room, point, or exit. The last destination for the 
occupant can be thought of as the occupant’s sink. By default, there is one behaviour in 
the model called “Goto Any Exit.” This behaviour simply makes the occupant move 
from their starting position to any exit present in the model by the fastest route. 

As with profiles, any number of occupants can refer to a single behaviour. Any changes to the 
behaviour will be reflected in referring occupants. 

Creating a New Behaviour 

To create a new behaviour, right click the Behaviours node from the Navigation View, 
and from the right-click menu, click Add a Behaviour…, which will open the New 
Behaviour dialog shown in the next figure. In the New Behaviour dialog, enter a 
behaviour name, and optionally specify an existing behaviour to base the new 
behaviour on. Using this option will copy all the actions from the existing behaviour. 

 

Figure 16 – New Behaviour Dialog in Pathfinder 

With the new behaviour selected, the behaviour property panel will appear as shown in 
Figure 17. 

 

Figure 17 – Behaviour Property Panel in Pathfinder 
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Initial Delay specifies an initial delay that makes the occupant wait at their starting 
position before moving to the next action. If this link is clicked, it will show a dialog 
where different distribution curves can be entered for the delay, similar to those 
discussed in Profiles. 

Adding Actions 

Additional actions can be added to any behaviour, such as going to a room, a waypoint, 
an elevator, or simply waiting in place. To add an action, select a behaviour or existing 
behaviour action. The property panel (Figure 18) will show a drop-down button with 
the description of an action that can be added. To add the currently shown action, 
simply click the button. To add a different action, click the down-arrow shown to the 
right of the button and select the desired action from the behaviour actions list. 

 

Figure 18 – Behaviour Actions List in Pathfinder 

Once the desired action is clicked, a creation panel will be shown above the 3D/2D 
View depending on the action. Enter the desired parameters in the creation panel as 
discussed in the following sections, and then click Create to create the action and 
append it to the behaviour. If the behaviour itself was selected when adding the 
action, then the new action will be appended to the end of the list. If, instead, an action 
was selected when the new action was created, then the new action is inserted 
directly after that selected action. 

Actions always occur in the order shown in the Navigation View. 
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Behaviour Action Types 

In Table 1there is a brief description about the behaviour action types 

Action Description 

Goto Waypoint Specifies that an occupant should go toward a specific 
point on the navigation mesh. 

Goto Rooms Specifies that an occupant must select a room out of a 
set and go to it. 

Goto Elevators Tells an occupant to use evacuation elevators 

Wait Tells an occupant to wait in their current location for a 
specified amount of time. 

Wait until Instructs an occupant to delay their movement until a 
specified simulation time passes. 

Assist occupants 
Instructs the occupant to join an assisted evacuation 
team and begin assisting occupants who request 
assistance from that team. 

Wait for assistance Indicates that the occupant should wait for assistance 
from other occupants. 

Detach for assistants Detaches a client from their assistants, allowing the 
assistants to continue helping other clients. 

Goto refugee rooms Instructs the occupant to go to one of a set of rooms 
marked as refuge areas. 

Goto exits Instructs an occupant to take the fastest route to a set 
of exits. 

Change behaviour Instructs an occupant to change a behavior to a new 
behavior picked randomly from a behavior distribution. 

Table 1 – Brief description of behavior action types 

The Goto Waypoint Action 

A Goto Waypoint action specifies that an occupant should go toward a specific point on 
the navigation mesh. Once they arrive within a certain radius of the point, they will 
move on to the next action in their behaviour. 

The Goto Rooms Action 

A Goto Rooms action specifies that an occupant must select a room out of a set and go 
to it. Once they cross a door into the room, they are considered to be in the room and 
can move on to the next action in their behaviour. If multiple rooms are specified for 
the action, the occupant will go to the one that is fastest to reach. 
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The Goto Elevators Action 

A Goto Elevators action tells an occupant to use evacuation elevators. When using this 
action, an occupant will go to a specified elevator, call it, wait for it to arrive, enter it, 
and then wait for it to reach the discharge floor. Once they reach the discharge floor, 
they can begin their next action. The Goto Elevators action can only be used for 
occupants who are not on the discharge floor of the desired elevator. If multiple 
elevators are specified for the action, the occupant will use the one that allows them to 
reach the discharge floor fastest. 

The Wait Action 

A Wait action tells an occupant to wait in their current location for a certain amount of 
time. Once that time has elapsed they will begin their next action. 

The way they wait will vary depending on their most recent destination. For instance, 
if their previous destination was a waypoint, they will try to stay close to the centre of 
the waypoint. If the previous destination was a room, they will try to move toward the 
furthest point in the room away from all active doors. This allows other occupants to 
enter the room. If their previous destination is an elevator, they will first move toward 
the walls as in waiting in a room, and then stand still when the elevator travels. In all 
cases, a waiting occupant will move out of the way of occupants headed toward a 
destination unless the destination overlaps with the waiting occupant’s most recent 
destination. 

The Wait Until action 

A Wait Until action instructs an occupant to delay their movement until a specified 
simulation time passes. This action is useful for synchronizing movement of many 
occupants at a time. Occupants fill space during a Wait Until action per the same rules 
described for the Wait action. Wait Until actions can be specified using three different 
approaches: occupants can wait until a specific time, the next in a list of times, or the 
next time in a periodic function. 

The Assist Occupants action 

This action instructs the occupant to join an assisted evacuation team and begin 
assisting occupants who request assistance from that team. When an occupant joins a 
team, they become an assistant. Once all occupants requesting assistance have 
completed their actions for which they wanted assistance, the assistant will begin 
their next action. 

The Wait for Assistance action 

This action indicates that the occupant should wait for assistance from other 
occupants. This action requires that the occupants using it have a vehicle shape with 
at least one attached occupant location. When an occupant begins this action, they are 
a client, and assistants will approach the client. The client cannot move once they 
begin waiting for assistants until enough assistants attach to the client to fill all the 
attached occupant positions. Once all positions are filled, the client begins their next 
action. The assistant will stay attached to the client until either the client has 
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completed all subsequent actions, or the client begins a Detach from Assistants action 
as described below. 

The Goto Refugee Rooms Action 

This action instructs the occupant to go to one of a set of rooms marked as refuge 
areas. Like the Goto Exits action, this action must be the last action in the behaviour. 
When an occupant reaches the refuge area, they will remain in the simulation and wait 
for the simulation to complete. Their behaviour while waiting is described in the Wait 
action above. 

The Goto Exits Action 

This action causes an agent to take the fastest route to a set of exits. Like the Goto 
Refuge Rooms action, this action must be last in the behaviour. Once an agent goes 
through an exit, they are removed from the simulation and reported as having exited 
the model in the Occupants Summary and Occupant History output files. 

The Change Behaviour Action 

This action causes an occupant to switch its behaviour. After this action, the occupant 
will start performing actions from a different behaviour. This new behaviour is 
randomly selected from a given behaviour distribution. Besides other behaviours, the 
same behaviour and No Change can also be selected. If the occupant changes 
behaviour to its current behaviour, the behaviour will be restarted. If the occupant 
selects to make No Change, the Change Behaviour action will have no effect. It is 
possible to create loops in the behaviour references. That way the occupant might 
keep performing the actions forever (until the end of the simulation). Note that 
depending on the specific setup, it is possible that actions that come after a Change 
Behaviour action will not be performed by the occupant. 

3.5.3 Generating Occupants 

Occupants can be added to the simulation in several ways. The simulation can either 
be pre-seeded with any number of occupants or it can have occupants continuously 
generated by occupant sources. When pre-seeding the model, occupants can be placed 
individually in the 3D or 2D view, distributed in a rectangular region of a particular 
room, or distributed throughout the entire area of a room. 

Individual Placement 

Individual occupants can be added to the model with the Add Occupant tool. 
Occupants can only be placed in pre-existing rooms, stairs, and ramps and cannot 
overlap other occupants or room boundaries. Left-click a desired position with the 
mouse or enter an x-y-z coordinate and press the Create button from the property 
panel to place an occupant. 
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Group Placement 

Groups of occupants can be added to the model with the Add Occupant Group tool. The 
occupants are distributed throughout this region using parameters in the property 
panel. 

Room Placement 

In addition to distributing occupants in placement regions, occupants can be 
distributed throughout entire rooms. To do this, select the desired rooms and choose 
Add Occupants… from the Model menu or the right-click menu. This will bring up the 
Add Occupants dialog. For an explanation of the dialog’s options, please see the 
section, Group Placement. Click the OK button after selecting the desired options to 
place occupants and exit the dialog. 

3.6 Simulating 

This is the last step to launch a simulation. 

3.6.1 Parameters 

The Simulation Parameters dialog provides a way to control certain features of the 
simulation, as well as provide some default values. 

The Time tab provides the following options: 

 Time Limit: can be used to automatically stop the simulation after a set 
simulation time.  

 Time Step Size: controls the resolution of simulation time steps. Increase the 
time step size to speed up simulations, reduce the time step size to ensure 
simulation accuracy. 

The Output tab provides the following options: 

 3D Output Freq: controls the time between 3D output file updates. Increasing 
this value causes data to be written less often, leading to less disk usage and run 
faster simulations (no file write delay), but can produce a misleading 3D results 
visualization. In the 3D results visualization, occupants will move in a straight 
line between two data points – if the two points are far apart in time, an occupant 
might appear to pass through an obstruction when it actually navigated properly.  

 CSV Output Freq: controls the time between CSV output file updates. Increasing 
the value causes fewer rows to appear in the resulting CSV files (i.e. lower data 
resolution). This option has a negligible effect on simulation performance or disk 
usage but can affect performance in the 2D results. 

 Runtime Output Freq: controls the time between simulation status updates in the 
Run Simulation dialog. This option has a negligible effect on simulation 
performance or disk usage. 
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 Jam Velocity: controls the speed threshold at which occupants are recorded as 
being jammed in the Occupants output file. 

 Occupant CSV Data: controls how the CSV data is generated for occupants with 
Print CSV Data enabled. 

3.6.2 Starting a Simulation 

To run a simulation: on the Model menu, click Run Simulation. The simulation will 
begin and the Run Simulation dialog. 

A simulation can also be paused, resumed, and cancelled at any time. 
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4 PRACTICAL CASE TO BUILD A MINE MODEL FOR EVACUATION 
SIMULATIONS 

Before modelling a mine evacuation process with the Pathfinder software, it is 
important to be clear on how to choose the evacuation model’s features. 

4.1 Introduction 

The study focused on a practical case in Velenje Mine, where several simulations were 
carried out in order to assess the mine’s safety. 

Two kinds of simulations were launched: 

 Simulations type 1: fire simulations covering the whole escape route of the 
mine. 

 Simulations type 2: sensitivity analysis assessing the effect of varying the 
mine’s cross-sectional area. 

The smoke and harsh conditions that take place in the smoke path make the 
evacuation more difficult, mainly because of the lack of visibility, that provokes a 
dramatic reduction in the evacuation velocity. This applies to the simulations type 1, 
because its interest is calculating the evacuation time and assessing whether the 
miners can get to a safe zone. 

To carry out the simulations type 2, the worst scenario from the simulations type 1 is 
chosen. Then, geometrical changes are studied, which allows to know the range of 
values where the fire effects are worse for miners. The results are examined through 
the variables of the fire (visibility, temperature, CO concentration) and also through 
the radiation, which is rather related to the fire service’s intervention to extinguish 
the fire. 

In the present document, a user’s guide is presented to elaborate and launch an 
evacuation simulation. 

The steps to take in order to make an evacuation study are as follows: 

 Launch several CFD fire simulations, varying some aspects of the scenario (fire 
location, fire power, ventilation regime, burning material). 

 Assess the evolution of the main variables (temperature, visibility, CO 
concentration) in the escape route. 

 Select the worst scenario to make a sensitivity analysis. 

 Launch several evacuation scenarios considering the fire simulations already 
carried out. 

 Assess if the smoke effect on miners during the evacuation allows them to get 
to a safe zone. 
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4.2 Preliminary CFD Simulations 

The first step to take to make a complete evacuation study is to launch several CFD 
simulations. Two sorts of simulations have to be considered: one to analyse the smoke 
conditions in the evacuation route and another one to assess how the geometrical 
changes affect the fire evolution. 

4.2.1 Simulations in the Whole Escape Route 

This kind of simulations covers the whole escape route of the miners. Several aspects 
have to be specified: the fire location, the miners’ location and the escape route the 
miners take, making the assumption that the fire blocks the miners’ route. 

For example, for a coal mine, if a fire takes place in the vicinity of the coal face, it can 
be assumed that there is a permanent airflow (whose value can be changed to study 
its impact), as shown in Figure 19. 

 

Figure 19 – Fire and Evacuation Scenario 

This model can be studied modifying some parameters, such as the fire location, the 
ventilation regime, etc. This way, four scenarios can be analysed: SC-1, SC-2, SC-3 and 
SC-4, as it is outlined in Table 2. 
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Scenario Fire Location Material Ventilation Rate (m3/min) 

SC-1 
Connection  
(Coal Face –  

Downstream Gallery) 
Conveyor Belt 

Nominal ventilation rate 
Upstream Gallery: 1710 m3/min 
Downstream Gallery: additional 520 m3/min 

SC-2 
Connection 
(Upstream 

Gallery – Coal Face) 
Conveyor Belt 

Nominal ventilation rate 
Upstream Gallery: 1710 m3/min 
Downstream Gallery: additional 520 m3/min 

SC-3 
Connection  
(Coal Face –  

Downstream Gallery) 
Conveyor Belt 

50% Nominal ventilation rate 
Upstream Gallery: 855 m3/min 
Downstream Gallery: additional 260 m3/min 

SC-4 
Connection 
(Upstream 

Gallery – Coal Face) 
Conveyor Belt 

50% Nominal ventilation rate 
Upstream Gallery: 855 m3/min 
Downstream Gallery: additional 260 m3/min 

Table 2 – Fire Scenarios to be Studied 

4.2.2 Results in the Fire Vicinity 

These scenarios are illustrated in Figure 20 – Figure 23. 

 

Figure 20 – Scenario 1 in the Whole Mine 
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Figure 21 – Scenario 2 in the Whole Mine 

 

Figure 22 – Scenario 3 in the Whole Mine 

 

Figure 23 – Scenario 4 in the Whole Mine 

Once all the simulations have finished, it is possible to determine which scenario 
presents the worst results in terms of safety. 
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The results of the main variables (temperature, CO concentration, visibility) in the 
nearby downstream region (not far from the fire) allow to determine the worst 
scenario, as shown in Figure 24 and Figure 25. 

 

Figure 24 – Temperature Variation in the Downstream Region 

 

Figure 25 – CO Concentration Variation in the Downstream Region 

4.2.3 Results in the Downstream Region 

It has been verified que the scenario 4 constitutes the worst scenario among the four 
scenarios that have been studied. 

The results of the main variables (temperature, CO concentration) in the downstream 
region, which is the main evacuation route, are the ones shown in Figure 26 and 
Figure 27. 
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Figure 26 – Temperature Evolution in Downstream Region 

 

Figure 27 – CO Concentration Evolution in Downstream Region 

These results allow to have an idea of how harsh the conditions are in the downstream 
region during the miners’ evacuation. 

4.2.4 Simulations in the Fire Vicinity 

Thanks to the previous simulations, it is possible to know that the scenario 4 is the 
one that presents the worst results in terms of safety. Therefore, this is the one that 
should be selected to conduct the simulations. 

The next step consists of setting up geometrical changes in the model. These changes 
are progressive reductions in the mine’s cross-sectional area. 

The comparison among all the areas studied allow to determine the most 
unfavourable case, as shown in Figure 28 – Figure 30. 



Information Driven Incident Response RFCS INDIRES 

User Documentation for Evacuation Simulation Software 41 

 

Figure 28 – Temperature Maximum in the Fire Source 

 

Figure 29 – Temperature Maximum in the Downstream Region 
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Figure 30 – Length of Regions with Radiation > 2.5 kW/m2 

This analysis has allowed it to be determine which scenario is the most unfavourable 
and the cases where a fire service’s intervention would be more complex because of 
the more spread radiation. 

4.3 Evacuation Simulations 

The first step of launching a wide variety of CFD fire simulations is already covered; 
this allows the most unfavourable case of fire in the mine to be selected. 

The next step consists of launching several evacuation simulations, integrating the 
CFD simulations. This way, it is possible to take into account the smoke evolution and 
to assess in which measure the toxicity and visibility affect the miners during their 
process of evacuation. 

4.3.1 Choice of the Scenarios to Analyze 

For example, if we continue the study with the scenarios SC-2 and SC-4, we can have 
an evacuation analysis with two cases, as outlined in Table 3. 

Scenario Fire Location Cross-sectional area Ventilation Rate (m3/min) 

SC-2 
Connection 
(Upstream 

Gallery – Coal Face) 
14 m2 

Nominal ventilation rate 
Upstream Gallery: 1710 m3/min 
Downstream Gallery: additional 520 
m3/min 

SC-4 
Connection 
(Upstream 

Gallery – Coal Face) 
14 m2 

50% Nominal ventilation rate 
Upstream Gallery: 855 m3/min 
Downstream Gallery: additional 260 
m3/min 

Table 3 – Fire Scenarios to Continue with Evacuation Simulations 
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4.3.2 Creation of the Geometry 

The geometry of each scenario exists in cad format but also it is available in FDS 
format, since it has already been launched in this program. 

Therefore, the best is to get the same file that has been used in the FDS simulation and 
import it in the evacuation program Pathfinder, as shown in Figure 31. 

 

Figure 31 – Mine Geometry Integrated in Evacuation Software 

4.3.3 Setup Escape Routes 

When the geometry is integrated in the evacuation model, it is possible to define all 
which is related to the evacuation: the escape routes, the exit, the obstacles to avoid, 
etc. 

It is necessary to define the routes that miners will take when a fire is declared, as 
shown in Figure 32. 
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Figure 32 – Setup of Mine Geometry 

Besides, in order to correctly model the miners’ velocity, it is important to know 
where the obstacles are placed, something that can be done thanks to the photos of 
the inside of the mine, as shown in Figure 33. 

 

Figure 33 – Obstacles in the Escape Route 

This way, it is possible to represent some objects in the galleries, such as the conveyor 
belts or other devices. It is necessary to define both the escape routes and the 
intervention routes for the fire service, as explained in Figure 34 and Figure 35. 
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Figure 34 – Escape Routes in a Mine after the Fire is Declared 

 

Figure 35 – Intervention Routes in a Mine after the Fire is Declared 

Since there are miners at both sides of the fire (upstream and downstream), there are 
two escape routes, which can be appreciated in the previous figure. When the 
emergency services get to the mine, they try to get closer to the fire through the 
upstream gallery. 
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4.3.4 Definition of the Users 

It is necessary to define all the features of the miners, as defined here: 

 Physical features, 

 Evacuation velocity, 

 Pre-movement time, 

 Interaction with other miners. 

Besides, there is an aspect that is necessary for the evacuation simulations, which is 
the regions where the velocity is reduced because of the lack of visibility. 

This can be obtained thanks to the CFD simulation, since it shows where the visibility 
attains levels lower that 10m, considered critical, according to NFPA 130. 

Besides, it is necessary to define the moment upon which the first miner is aware of 
the occurrence of a fire. In the CFD simulation, it is possible to estimate when this 
happens, since some emergency devices are placed throughout the mine: 

 Smoke detector, 

 Temperature detector, 

 Carbon monoxide detector. 

Once this time is known, it can be specified in the evacuation model. 

4.3.5 Integration of CFD Results 

It is possible to import these results in the evacuation model, so that the evacuation 
process will calculate the effect of the smoke. 

In the case of a coal mine, the miners carry SCSR units, which allow them to have fresh 
air to breathe during its autonomy, which is usually 30 minutes. 

Therefore, the time upon which it is necessary to assess the impact of the smoke on 
miners is after the SCSR autonomy is finished. So, the first aspect to verify is whether 
the miners are able to get to a safe zone before the autonomy is over. 

On the other hand, the effect of the temperature on miners is something that does not 
depend on the fact of whether the miners carry SCSR units or not and should be 
evaluated. 

The integration of the CFD results allow to see at the same time the evolution of the 
fire (all the variables related to it) and the evacuation process, as it can be appreciated 
in Figure 36 – Figure 41. 
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Figure 36 – Visibility Evolution in the Mine (t=60s) 

 

Figure 37 – Visibility Evolution in the Mine (t=120s) 

 

Figure 38 – Visibility Evolution in the Mine (t=240s) 
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Figure 39 – Visibility Evolution in the Mine (t=360s) 

 

Figure 40 – Visibility Evolution in the Mine (t=540s) 

 

Figure 41 – Visibility Evolution in the Mine (t=690s) 
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4.3.6 Assessment on the Evacuation Results 

As explained before, the assessment of the fire’s effect on miners has to be done 
through two variables: 

 CO concentration, 

 Temperature. 

The miners are not affected by the fire’s toxicity while the SCSR is working, since it 
provides fresh air during its autonomy and they do not have to breathe smoke. 

However, the temperature affects miners and should be evaluated, despite the fact 
that they carry SCSR units. 

Besides the evacuation, it has to be analyzed the time required for the fire service to 
get to the place where the fire is located and verify if they can approach it with a 
registered level of radiation below 2,5 kW/m2. 
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5 FURTHER INFORMATION 

Geocontrol has experience in the domain of evacuation simulations in coal mines and 
is always looking forward to collaborating in projects related to coal mines. Further 
information about evacuation simulations and studies carried out by Geocontrol can 
be solicited. 

Please contact Rafael Sanchez at rsanchez@geocontrol.es 

 



 

 

 


